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1. Legal Notice

1.1. Contact Details

Berghof Automation GmbH
Harretstr. 1

72800 Eningen

Germany

T +49.7121.894-0

F +49.7121.894-100

E-mail: controls@berghof.com
www.berghof.com

1.2. Version Detalils

1.2.1. Manual

Revision history

Version Date Comments / changes

1.0 19.09.2017 First issue

1.10 11.08.2017 Safety ratings updated after review by TUV Rheinland

1.20 16.11.2017 Declaration of Conformity and TUV certification added

1.30 14.05.2018 Objects 210An "SW Build No.“ and 2212, “Post Result Flag” added.
User instructions for Safety Task time settings added.
Note on the Safety ERRATA sheet inserted

1.40 05.02.2020 Chap. 7.3.20 Read MC 3 Error 2210h updated. For details see

ERRATA Sheet.

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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1.2.2. Manual version / E-I/O Safety PLC version

The table below describes the relationship between the module releases (module versions)
and the corresponding manual version.

Module release

Version Manual Date Comments / changes

VvV 1.00 V 1.20 From Initial release / valid for module release V 1.00
16.11.2017

VvV 1.04 V 1.40 From Manual updated
14.05.2018

1.2.3. Terms used

Safety PLC The Safety PLC described in this document

Standard PLC The main PLC of the system, which provides the EtherCAT Master.
CODESYS The programming environment for the main PLC

Safety Package CODESYS Safety extension

PLCopen Safety Certified library of safety function blocks

E-1/0 System E-1/0 module family

E-1/0 PLC PLC for the E-I/O system

Head module General designation for bus couplers or small PLCs in the E-I/O system

CODESYS Safety extension  Certified safety programming environment

Logical exchange variables These serve to exchange information between the safety PLC and the
standard PLC (see CODESYS Safety user guide)
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2. Preface

2.1. About this User Manual

This document is the user manual for the safety PLC module with the product number 204909000.
When working with the module, always refer to the CODESYS Safety user guide, in the corresponding
version certified for use with CODESYS Safety Runtime 1.2.0 (4.1.2.0), published by 3S-Smart
Software Solutions GmbH.

This document is intended for the target group described in section 2.2.2 Target groups of this User . It
does not contain any information about deliveries. We reserve the right to make changes and correct
errors and omissions. lllustrations are similar.

ﬂ Refer to the Safety ERRATA document for the current relevant safety warnings.

The current version con be found on our home page
https://www.berghof-automation.com

Under Products > Safety PLCs > General Information

2.1.1. Limitation of Liability

Specifications are only for product description and are not to be understood as guaranteed product
properties in a legal sense. Exact properties and characteristics shall be agreed in the specific contract.
Claims for damages against us - on whatever grounds - are excluded, except in instances of deliberate
intent or gross negligence on our part.

2.1.2. Conditions of delivery

The general conditions of sales and service of Berghof Automation GmbH shall apply.

2.1.3. Copyright

Copyright © Berghof Automation GmbH

This user manual is protected by copyright.

No part of this document may be reproduced or copied in any way or by any means except expressly
permitted in writing by Berghof Automation GmbH.

Microsoft®, Windows® and the Windows® logo are registered trademarks of Microsoft Corp. in the
USA and other countries.

EtherCAT® is a registered brand and patented technology, licensed by Beckhoff Automation GmbH,
Germany.

Safety over EtherCAT is a registered trademark and patented technology, licensed by Beckhoff
Automation GmbH, Germany.

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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2.1.4. Warranty

Warranty is subject to the provisions of the conditions of sale of Berghof Automation GmbH or any
contractual agreements between the parties.

The warranty will be voided by:

improper assembly and use,

repairs or inadmissible servicing,

opening the module housing,

modifying, defacing or removing the serial number.

N2 20\ 4

2.1.5. Symbols and means of portrayal

The following symbols and means of portrayal are used in this User Manual:

> e List entry

> Individual operational instructions or list with operational instructions, which can

be displayed in any sequence.

—

List with operational instructions, which can be displayed in any sequence.

ﬂ Further information on the product

10
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2.2. Reliability, Safety

2.2.1. Area of application

This user manual contains all the information you need to use the product described as intended.

2.2.2. Target groups of this User Manual

The user manual is written for design, project planning, servicing and commissioning experts. For
proper understanding and error-free application of technical descriptions, instructions for use and
particularly of notes of danger and warning, extensive knowledge of automation technology and
functional safety is compulsory.

2.2.3. Hazards and Other Warnings

Despite the actions described in section 2.2.5 Safety, the occurrence of faults or errors in electronic
control units - however improbable - must be taken into consideration.

Please pay particular attention to the additional notices which we have marked by symbols throughout
this user manual. While some of these notices make you aware of possible dangers, others are
intended as a means of orientation. They are described below in descending order of importance.

Every alert and hazard warning is made up as follows:

Optional: Type and source of risk
Other symbols Brief description and potential consequences of non-observance
> Preventive measures

The signal terms described below are used for warning instructions which you must comply with for
your personal safety and for avoiding damage to property.

Aomesm

A DANGER warning makes you aware of an immediately hazardous situation which WILL cause a
serious or fatal accident if not observed.

A WARNING makes you aware of a potentially hazardous situation which MAY cause a serious or
fatal accident or damage to this or other devices if not observed.

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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A CAUTION

A CAUTION alert makes you aware of a potentially hazardous situation which MAY cause an
accident or damage to this or other devices if not observed.

2.2.4. Other Notices

ﬂ Note, Information

This symbol draws your attention to additional information concerning the use of the described
product. This may include cross references to information found elsewhere (e.g. in other manuals).

2.2.5. Safety
Our products normally become part of larger systems or installations. The information below

is intended to help you integrate the product into its environment without dangers to people
or materials/equipment.

A DANGER

Non-compliance with the user manual

Measures for the prevention of dangerous faults or errors may be rendered ineffective or new hazard
sources created.

» Read the user manual carefully.
»  Take particular heed of the hazard warnings.

ﬂ To achieve a high degree of conceptual safety in planning and installing an electronic control unit, it
is essential to exactly follow the instructions given in the user manual because wrong handling
could lead to rendering measures against dangers ineffective or to creating additional dangers.

12
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2.2.6. Project Planning and Installation

> Safety and precautions regulations for qualified applications must be complied with.

> Please pay particular attention to the notices of warning which, at relevant places, will make you
aware of possible sources of dangerous mistakes or faults.

> Relevant standards and VDE regulations must be complied with in every case.

-  Control elements are to be installed in such a way as to exclude unintended operation.

2.2.7. Maintenance and Servicing

- Accident prevention regulations (in Germany: BGV A3 - VBG 4.0) must be observed when
measuring or checking a control unit after power-up, in particular §8 (permissible deviations
when working on parts).
The Safety PLC Module is maintenance-free, there are no spare parts available
Repair work on the Safety PLC Module is not permitted. In the event of a defect,
return the module to Berghof Automation GmbH, with a description of the fault.
-> Installation, and changes to the connections, may be performed only in the de-energised state.
Otherwise damage the modules may be seriously damaged or their functionality impaired.
In addition, unexpected hazardous situations may arise, which can lead to accidents.

v

2.2.8. General Instructions on Installation

As component parts of machines, facilities and systems, electronic control systems must comply

with valid rules and regulations, depending on their field of application.

General requirements concerning the electrical equipment of machines and aiming at the safety of
these machines are contained in Part 1 of European Standard EN 60204 (corresponds to VDE 0113).

ﬂ For safe installation of our E-I/O safety system, the instructions described in section 6 Installation
and Operation must be complied with.

Emission of interference
Emission of electromagnetic field interference, HF to EN 55011, limit value class A, Group 1

ﬂ If the control unit is used in residential areas, high-frequency emissions must comply with limit value
class B as described in EN 55011.
A shielding compliant to the above standard can for instance be achieved by fitting the control unit into
earthed metal cabinets and installing filters in the supply lines.

The design and immunity to interference of programmable logic controllers are internationally
governed by standard IEC 61131-2:2007 which, in Europe, has been the basis for European Standard
EN 61131-2:2007.

ﬂ Refer to IEC 61131-4, User's Guideline, for general installation instructions to be complied with to

ensure that hardware interface factors and the ensuing interference voltages are limited to tolerable
levels.

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx 13
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Protection against the effects of external electrical interference
> To eliminate electromagnetic interference, connect the control system to the protective earth
conductor.

Cable routing and wiring
> Route power circuits separately from control circuits:
DC voltages 60...400 V
AC voltages 25...400 V
> Route only the following control circuits together:
Shielded data signals
Shielded analogue signals
Shielded Digital 1/O cables
Unshielded DC voltages < 60 V
Unshielded AC voltages <25V

Location of installation
> Ensure that temperatures, contaminations, impact, vibration or electromagnetic interference
are no impediment to the installation.

Temperature
> Take heat sources into account: general heating of rooms, sunlight, heat accumulation
in assembly rooms or control cabinets.

Contamination
> Use suitable enclosures to avoid possible negative influences due to humidity, corrosive gas,
liquid or conducting dust (such as installation in a suitable control cabinet).

Impact and vibration
> Consider possible influences caused by motors, compressors, transfer lines, presses, ramming
machines and vehicles.

Electromagnetic interference

> Consider electromagnetic interference from various local sources: motors, switching devices,
switching thyristors, radio-controlled devices, welding equipment, arcing, switched-mode power
supplies, converters / inverters.

14
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3. System Description

The purpose of the Safety PLC is to integrate functional safety functions into control systems. There is
no need for separate cables for the safety circuits. The Safety PLC has the duty of executing the safety
application program and exchanging safety-related control information with the safe slave modules

assigned to it.

Fig. 1: Safety PLC

A pre-requirement for the use of the Safety PLC is the use of a supervisory PLC based on CODESYS,
referred to below as the main PLC, together with EtherCAT as a field bus for data exchange.

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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3.1. Control system — functional overview
The diagram below depicts an example of a control system with a Safety PLC.

Programming System

(CODESYS) Standard-PLC Standard /0 Safety Inputs
EtherCAT- EtherCAT- =
Slave Slave —
F! I =
EtherCAT- SoE Slave =
[ F— "™ =
______ I el
I safety PLC
I (safety control unit) Safety Inputs Safety Outputs Standard /0
1 — — =
1 EtherCAT- = = EtherCAT- = EtherCAT-
1 Slave = = Slave = Slave
\ FSoE Master = = FSoE Slave =
| e == S
1

Fig. 2: System overview

The programming PC with the programming system programs the standard PLC via the Ethernet
connection. One or more Safety PLCs can then be programmed by the standard PLC via the
EtherCAT field bus.

When the system is in operation, process data are exchanged between the standard PLC and
the standard actuators and sensors.

At the same time the Safety PLC uses the EtherCAT field bus and the FSoE protocol to exchange
safety-relevant signals with safe 1/0O modules or drives.

3.2. EtherCAT® — Ethernet Control

EtherCAT is an Ethernet-based field bus system. Its speed, flexible topology and ease of configuration
make it suitable for use as a quick drive and I/O bus for control units (industrial PCs or PLCs).

Its interconnections between the controller at one end and both the I/O modules and drives at the
other are as fast as those of a backplane bus. EtherCAT control units thus act virtually as centralised
control systems.
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3.3. E-l/O system

The Safety PLC is a module within the E-1/O system. The E-I/O system is a collection of I/O modules
which can be stacked in a row for incorporation into an EtherCAT network for transmission

of process signals.

The E-I/O bus coupler acts as the head module which converts the transmission from twisted pair into
LVDS (E-bus) and generates the system voltages required by the LVDS modules. The standard

100 Base Tx lines are connected to the one side. a succession of E-I/O modules are arranged in a row
for the process signals connect to the other side. This is how the EtherCAT protocol is retained right
through to the last I/O module.

An E-1/0O PLC can also be used instead of the bus coupler as the head module. This then takes over
the function of bus master from the standard PLC.

=
EtherCAT.

Fig. 3: E-I/O System

PLC with E-I/O expansion modules Expansion Modules
2 Bus coupler with E-1/O expansion 5 Bus coupler
modules
3 E-I/OPLC

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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3.4. E-I/O Safety System

The E-I/0O Safety System extends the E-I/O system by means of the Safety PLC and modules with safe
inputs and outputs described here. There is no need to provide separately cabled safety circuits. The
EtherCAT protocol is used to transfer both safe and standard signals to the Safety PLC. This integrated
transfer process is based on the certified FSoE safety protocol.

3.4.1. Safety over EtherCAT (FSoOE)

Along with EtherCAT, a safety protocol was developed and made available for EtherCAT as "Safety
over EtherCAT" (FSoE = Fail Safe over EtherCAT). It is the backbone of providing functional safety
over EtherCAT. Both the protocol and its implementation are certified to comply with Safety Integrity
Level 3 (SIL 3) to IEC 61508. Since 2010, Safety over EtherCAT has been defined in an international
standard, IEC 61784-3-12.

Since EtherCAT is used as the medium of communication, Safety over EtherCAT does not impose
any constraints regarding the transfer rate and cycle time. The transport medium is considered

a "black channel" which is disregarded in the safety assessment.

Safety over

EtherCAT.

Fig. 4: FSoE Logo

3.4.2. Safety PLC

The Safety PLC links the inputs and outputs of the E-1/O safety system and the safety-relevant signals
of other FSoE devices within the system.

It operates at all time in conjunction with a supervisory CODESYS-based PLC, here referred to as the
standard PLC.

The Safety PLC has a two channel architecture. It communicates to the programming system via the
standard PLC and the logical exchange variables (see CODESYS Safety user guide - “Logical I/Os*)
and to the standard PLC using non-safe variables, input and outputs.

3.4.3. CODESYS Safety

The Safety PLC is based on a certified plug-in that is fully integrated in the CODESYS

Development System.

The Safety PLC is programmed as an EtherCAT slave node under the standard PLC and provides an
application, task, lists of global variables, POUs and logical I/Os. It fulfils all the functions described in
version 1.2.0 of the CODESYS® Safety user manual. The only restriction: The integration operates only
in conjunction with EtherCAT as a communications medium to the Safety PLC.

The integrated function diagram (FD) safety editor (to IEC 61131-3, certified for use with IEC 61508
SIL3 applications) is used for basic or extended-level programming by means of certified function
blocks (IEC 61131-3 or PLCopen Safety) as specified in the CODESYS Safety user manual.
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At the basic level, certified function blocks (PLCopen-Safety) are graphically "wired up" to establish

the system's safety programme. In case that a project demands more than the technology of the
certified blocks can provide, the extra instructions available at the extended level can be used to
expand the safety programme.

The software offers further functions for safeguarding the safety functions by change tracking, safe flow
of signals, safe version control (pinning), separating safe operation, debugging mode, etc.

CODESYS

Fig. 5: CODESYS-Logo

3.4.4. PLCopen Safety Library in CODESYS

The PLCopen components have been defined and certified by the PLCopen organisation, its members
and external organisations specialising in all safety-related aspects. The components interlink by
logical operations which behave like logical wiring and therefore so that a safety application using
these components can be programmed reliably.

ﬂ Of itself the use of certified safe blocks is not sufficient to ensure that the user program is error-free.
Each program must be developed for the relevant safety functions and exhaustively tested.

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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4. Product Description

4.1. Product Description Safety PLC

The Safety PLC allows the integration of safety functions into a control system. The core of the Safety
PLC consists of two microprocessors which implement the safety functions and communicate with
each other to exchange process data and to mutually monitor each other. A third microprocessor
manages the external communications.

Modules can be installed in a row for incorporation in an E-I/O system. The module is designed for
installation on a DIN rail within a control cabinet.

Overview

8 =N
—— 1
g | ﬁ’ 2
|~
o
: |

Fig. 6: External features of the Safety PLC Module

Grip Screen connection to housing
2 Labelling clip 6 DIN rail attachment and effective earth
3 Unlock button 7  Module lock, E-bus
4  Status LEDs 8 Ventilation slots

The housing mount consists of an aluminium profile with an integrated clamping fixture used to attach
the module to a 35 mm DIN rail. The housing trough including the optical fibres for the status
indicators, the side faces and the front are made of plastic and contain the module.

20



USER MANUAL 1.40 | SAFETY PLC MODULE

4.2. Application

4.2.1. Intended Use

The E-I/O system is a system of I/O modules for interconnecting the process signals in an EtherCAT
network. It consists of the bus coupler and a range of I/O modules. The E-I/O Safety System with E-I/O
Safety PLC and the E-I/O Safety Modules extend the E-I/O System by adding functions which permit
use in the field of the functional safety of machines.

The intended applications of the FIO Safety System include safety functions of machines or systems
and all industrial automation tasks immediately associated with them. Thus the system may only be
used for applications providing a defined fail-safe state. The defined fail-safe state of the system

is the de-energised state. Running any of the safety-related control components is subject to the safety
precautions applicable to industrial control units (guarded by emergency stop and similar safety
equipment) as specified by the relevant national and/or international regulations. The same applies

to connected equipment such as drives or light grids.

Before installing and putting the system into operation, the safety instructions, connection
specifications (nameplate and documentation) and the limiting values listed in this user guide's
Technical Data section must be read carefully and complied with in every respect. The system is not
designed for applications causing potentially fatal risks or dangers to the life and health of many
persons or disastrous ecological hazards unless exceptionally strict safety precautions are taken.

In particular, the system is unsuitable for applications such as the monitoring of nuclear reactions

in nuclear power stations as well as the control of flight or air traffic control systems, means of mass
transit, medical life support systems and weapon systems and its use is not allowed.

In particular, its use is approved only in the context of the relevant Machinery Directive
(Directive 2006/42/EU).

A WARNING

Impairment of safety due to the use of unsuitable EtherCAT modules!
»  The Safety-PLC may be operated only in conjunction with bus modules which conform to ETG.

A WARNING

Impairment of safety due to the use of unsuitable FSoE slave modules!

»  The Safety PLC may be operated only in conjunction with certified FSoE slaves which conform to
FSoE.

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx 21
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4.2.2. Qualified Persons

The safety-related products may be used only by the following persons:

> Qualified persons who know the applicable concepts of functional safety as well as the relevant
standards and regulations.

- Qualified persons who plan, design, install and put machine and system safety equipment into
operation.

Qualified persons in the sense of this User Manual are persons whose training, experience,

instructions and knowledge of the applicable standards, codes, accident prevention regulations and

operating conditions authorise them to perform the required work and enable them to recognise and

avoid potential hazards associated with that work. Language skills sufficient to understand this Guide

are therefore part of this qualification.

A WARNING

Incorrect operation by unqualified personnel!

»  Only qualified persons are allowed to install and program the Safety PLC.

4.2.3. Disclaimer of Liability

The operator is responsible for self-reliantly running the safety-related control components

in conformity with the requirements set by the competent authority.

The manufacturer shall neither be held liable nor accept any warranty for damages caused by:
inappropriate use,

non-compliance with standard and directives,

unauthorised modifications of devices, connections or settings,

use of unapproved or unsuitable equipment or equipment groups,

non-observance of the safety instructions contained in this manual.

N2 20 20 20 Z
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4.3. Safe State

There are two different types of "safe states”:

-  The first one is functional and depends on the machine's application, operation and software.
This is the desired functional safe state. The system is operating free of defects.

-  The second one is the fail-safe state and is adopted whenever a fault or error occurs in any
of the monitored components.

4.3.1. Safe Functional State

The Safe Functional State is the state of defect-free working operation.

This state also includes situation where modules associated with the Safety PLC are reporting a fault.
In general these do not lead to exiting the functional safe state, instead they are dealt with in relation
to the safety application (e.g. loss of communication to a safe /0 module).

4.3.2. Fail-Safe State

Internal Fault

The Fail-Safe State of the Safety PLC is the state in which no valid FSoE telegrams are being sent to
the participating FSoE slaves. If valid FSoE telegrams are outstanding the FSoE slaves adopt the safe
state (de-energised outputs).

Internal faults which pose a safety hazard lead to the stoppage of FSoE communication, and thus
trigger a switch into the fail-safe state. FSoE communication is then stopped. Insofar as this is possible,
EtherCAT communication remains active and permits diagnostic activities.

External Fault

The module monitors its supply voltage (overvoltage and undervoltage) and also the permissible
operating temperature. It any of these strays outside the permissible range the Safety PLC switches
to the fail-safe state and no more FSoE telegrams are sent out.

Exiting the fail-safe state

The fail-safe state can be exited only by switching off the power supply to the head module (bus coupler
or PLC). When the system is switched on again it performs a complete self-test as part of the
initialisation phase.

In accordance with the FSoE specification, when no correct FSoE telegram is received within the
watchdog expiry time the FSoE slaves that are connected switch into the safe state.

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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4.3.3. Traceability

Traceability means that the time and entity that produced, processed, stored, transported, consumed
or disposed of a product or trading good can be traced back at any time

Whereas Berghof Automation GmbH is able to meet this requirement with regard to the production,
processing, storage and transport, the purchaser is responsible for all further whereabouts of the product.

The serial number provides the means of uniquely identifying and tracing the product. You can find the
serial number printed on the front of the module and also as a sticker on the underside of the module.
It can also be read by software. To ensure proper traceability, the purchaser is obliged to note down

this number together with the name, place of installation and end customer of the machine.

ﬂ The purchaser must ensure the traceability of the units by means of this serial number.

4.4. Useful Life

Safety PLC Modules have a design life of max. 20 years from their date of manufacture
(see section 5.1 Labelling and Identification). The module must be taken out of use no later than
one week before expiry of these 20 years (see section 6.10.3 Decommissioning).

ﬂ The date of manufacture is printed on the housing as part of the serial number, and in addition is
stored in the memory of the Safety PLC (see section 5.1.2 Serial number).
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4.5. Technical Data

4.5.1. General specifications

Device data

Product name

Safety PLC

Field bus EtherCAT 100 Mbit/s
E-bus port 10-pin system plug in side wall
Memory for CODESYS A total of 512 kByte are available:

application and configuration
data

e 400 kByte for the CODESYS application
e 112 kByte for the configuration data

Electrical insulation

All modules electrically insulated from each another and from the bus

Diagnostics

LEDs (see section 5.3 Status LEDs)

E-bus load

max. 240 mA (system power supply)

Terminating module

Module bus cover necessary at the last module

System Power Supply

Supply voltage

5V DC via E-bus connection provided by the head module
(bus coupler or PLC in compliance with EN 61131-2, power supply 24
V DC, min. -15% / +20% SELV/PELV)

Overvoltage category

Category Il to IEC 60664-1, in compliance with EN 61131-2

Reverse polarity safeguard

yes

Immunity to interference

Installation in Zone B to 61000-6-2, in compliance with EN 61131-2,
installation on an earthed DIN rail in an earthed control cabinet. Lay
the earth according to the operating conditions. (see section 6.2.1
Earth)

Storage and transport conditions

Ambient temperature

-25...+70 °C

Rel. humidity

5...95 % non-condensing

Atmospheric pressure

70...108 kPa

Vibration 5...8.4 Hz: £3.5 mm amplitude, 8.4...150 Hz: 10 m/s? (1g),
to IEC 60068-2-6, Fc test
Shock 150 m/s? (15g), 11 ms semi-sinusoidal wave to IEC 60068-2-27

Operating conditions

Installation position

horizontal, stackable

Degree of contamination

Degree of contamination Il to IEC 60664-3

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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Permissible operating
environment

Operation is restricted to environments complying with IP54 or at least
IEC 60529 (e. g. in a suitable control cabinet)

Operating temperature

0...+55°C

Relative humidity

5...95 % non-condensing

Atmospheric pressure

80...108 kPa

Installation altitude

Maximum 2000 above mean sea level

Vibration 5...8.4 Hz: £3.5 mm amplitude, 8.4...150 Hz: 10 m/s? (1g), to IEC
60068-2-6, test Fc
Shock 150 m/s2 (15g), 11 ms semi-sinusoidal wave to IEC 60068-2-27

Mechanical properties

Mounting

35 mm DIN rail (top-hat rail)

Dimensions (W x H x D)

25 mm x 120 mm x 90 mm

Ingress Protection

IP20

Housing mount

Aluminium

Screen connection

connects straight to module housing

45.2. Size of the FSoE data frame

The FSoE protocol defined a maximum frame size of 1322 bytes. This is the maximum size of the data
that can be exchanged between a Safety PLC and an FSoE slave.

The maximum number of FSoE slaves to a Safety PLC is calculated by the addition of the respective
safe I/O data plus protocol overheads (these together yield the size of the frame). The size data can be
found in the product description of the respective FSoE slave.

Typical values for the size of the FSoE frame of a FSoE slave is dependent on the safe 1/0 usable data:

Payload data Size required by the slave in the FSoE frame
(bytes) (bytes)

1 6

2 7

4 11

8 19

16 35

32 67
In general:

Size of the FSoE frame = 2 x safe I/O data + 3 byte descriptive data (CMD + connection ID)
Subject to the minimum size of the frame: 6 bytes

ﬂ If during the configuration of a safety application the maximum size of the FSoE data frame stated above
is exceeded, the respective safety application will not start.
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4.5.3. Setting the cycle time for the safety application

The cycle time for the safety application is set in the programming system. It can be set to a value from
4 ms to a maximum of 600 ms in millisecond steps.

ﬂ Values outside the range cannot be set.
When such a safety application is loaded, the Safety PLC will return an error message.

For new safety projects it is recommended that the safety task time is set to a high value (e.g. 50 ms).
When the project is running, the safety task time actually required can be read in the object.
(SDO Object 2220 Subindex 4) This value can be accepted with a buffer (e.g. +20%).

4.5.4. Response Time

In a safety system consisting of the Safety PLC, safe I/0O modules connected via FSoE and associated
sensors and actuators, the overall response time is made up of the signal processing times of the
individual components (see diagram). For the operating Safety PLC the response time is the task
cycle time set in the safety application.

total time to respond

signal processing by sensor
signal processing by safe 1/0O module
data transfer via Ethercat
runtime of Safety PLC programme
data transfer via Ethercat

signal processing by safe I/O module
signal processing by actuator

T_Input T_Output

T_FSoE T_FSoE

T_SafetyPLC

- - module time to respond

system time to respond

Fig. 7: Response time in multi-module operation (example)

T_Sensor Processing time of the sensor until the signal is available at the interface.

Typically this is declared by the sensor manufacturer.

T_Input Processing time of the safe input, e.g. SI4/SO2 module.

This time can be found in the technical data of the input module.

T_FSoE Processing time of the communication. This is max. 3x the EtherCAT cycle time, since

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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new data are can always be sent only via a new Safety-over-EtherCAT telegram and
the data must then be copied from the supervisory standard PLC. The processing time
of the communication therefore depends directly on the cycle time of the EtherCAT

master.

T_SafetyPLC

Processing time of the Safety PLC. This is the set cycle time of the safety application.
If due to excessively high complexity of the program this cannot be achieved, the
Safety PLC will switch into the safe state.

T_Output Processing time of the safe output, e.g. SI14/SO2 module.
This time can be found in the technical data of the output module.

T_Actuator Processing time of the actuator. This information is typically provided by the actuator
manufacturer.

A CAUTION

To calculate the safe response time, take account of the fieldbus runtimes and the Safety PLC's

cycle time.

»  The field bus runtimes and the Safety PLC cycle time must be taken account of to calculate the safe

response time.

»  For the runtime of the field bus, a worst case of 3x the EtherCAT cycle time per directional signal
must be assumed.

slaves.

Since a fault may occur during the Safety PLC cycle, the maximum system response time must be
assumed for the design response time. This can be set by means of the watchdog time of the FSoE
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Fig. 8: Dimensions in mm

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx

25

A
\

Salety PLC

CEtherCAT Run
O Safe Status
aPLC

SN2 XOCOOXXXXXX

9 © O O
—

| 204909000 |

e e Y e
s i s Y e

29



USER MANUAL 1.40 | SAFETY PLC MODULE

4.6. Transport and Storage

At times of transport and storage, protect the Safety PLC against inadmissible exposure to conditions
such as mechanical stress, temperature, humidity and/or aggressive atmospheres.

>
>
>

Transport and store the Safety PLC in its original packaging.

When stock picking or unpacking, take care not to contaminate or damage the contacts.
Comply with the ESD instructions - store and transport the Safety PLC in suitable
containers/packaging.

Some parts of the units are sensitive to ESD and may be damaged if handled inappropriately.

> When commissioning and performing maintenance of the Safety PLC take the appropriate
precautions against electrostatic discharge (ESD).
A CAUTION

Electrostatic discharge

Destruction of or damage to the unit.

>

>
>
>

Transport and store the Safety PLC module in its original packaging.
Ensure that the ambient conditions are as specified at all times during transport and storage.
Handle the Safety PLC modules in a well-earthed environment (persons, place of work, packaging).

Do not touch electrically conductive parts such as data contacts. Some of the electronic components
may be destroyed if exposed to electrostatic discharge.
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5. Construction and Functionality

5.1. Labelling and Identification

5.1.1. Imprinted Texts and Symbols

Eherea™) L]
C €_ Safety PLC
e ’ D

LISTED

OEtherCAT Run
D Safe Status
oPLC

590M
E202595

B <> ®

E-IIO 204909000
Safety PLC V1.0

Protocol FSoE

Runtime CODESYS Safety

nr=1n

Temp.55°C max.

=

1D @ @ O
[ |

Pan - Y @ [ 204909000
Harretstrasse 1, D-72800 Eningen = oo
www.berghof.com s I s ) s

Fig. 9: Imprinted Texts and Symbols

Operating conditions 4 Serial number on the underside
2 Manufacturer’s label 5 Operative earth
3 Wiring diagram 6  Serial number on front face
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5.1.2. Serial number

The serial number is printed vertically on the front face. It can also be found on the rear face of the module.
The numerical code incorporates the production date and a serial number. The numerical code permits
Berghof Automation GmbH to perform unique identification of the model, software and hardware
release date.

@EherCAT Run)
@ Safe Status
@FLC

SN XXXXXXXXXXK

Fig. 10: Front view with serial number

Structure of the serial number:
YY MM DD NNNNN

Y = Year (production date)

M = Month (production date)
D = Day (production date)

N = sequential number

ﬂ The serial number is also stored in object 1018h sub-index 4 (see section 7.2.7
Identity Object 1018h) and can be read by EtherCAT SDO access.

5.2. Scope of delivery

->  Safety PLC
> Module bus cover
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5.3. Status LEDs

Safety PLC

@EtherCAT Run
@ Safe Status
QFPLC

—

Fig. 11: Status LEDs

Displays:

-  "EtherCAT Run” LED Status of the EtherCAT communication
->  LED "Safe Status" (Duo-LED): Status of the module regarding its safety function

> "PLC” LED: Status of the module

"EtherCAT Run” LED

Off Init Initialising, no data exchange
Off/green, 1:1 Pre-Op Pre-operational, no data exchange
Off/green, 5:1 Safe-Op Safe operation, inputs readable

Green continuous Op Operational, unrestricted data exchange

LED "Safe Status"

Green continuous OK Module is in the functional safe state
Red, continuous Error The module is in the fail-safe state
"PLC” LED

Off - Safety application not loaded
Offlyellow, 1:1 - Safety application is being loaded

Yellow, continuous -

Safety application is loaded

Green continuous -

Safety application is running

Red, continuous -

Safety application is stopped

Offlred, 1:1 -

Safety application was aborted

Offigreen, 1:1 -

The safety application is in Debug mode

ﬂ The status LEDs are not a safety-related display. Thus the displays of the status LEDs must not be
relied on as a reliable indication of the operating status of the module etc.

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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5.4. Operating Software

The Safety PLC is part of a decentralised CODESYS-based control system. The programming
of the Safety PLC is performed using a CODESYS-based programming system extended by the use
of a certified plug-in (CODESYS Safety Extension) that provides the safety functionality.

Incorrect programming and parameter setting

»  Perform programming and parameter setting only via the CODESYS Safety Extension approved for
use in conjunction with the CODESYS Safety runtime system version 1.2.0.

»  Perform programming and parameter setting in accordance with the relevant CODESYS Safety user
guide.
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6. Installation and Operation

> Before installation, verify that the Safety Module has been transported and stored under the ambient
conditions specified in section "4.6 Transport and Storage" and section "4.5 Technical Data*“.
> Module operation is subject to the service conditions specified in section 4.5 Technical Data.

A CAUTION

Incorrect operation

Safety PLC module malfunctions.

»  Only persons qualified for dealing with safety matters are allowed to add, replace and put Safety
PLC Modules into operation.

»  Before installing, servicing or putting Safety PLC Module into service, please also read the safety
information in this document.

»  Before putting the unit into service, verify that all safety functions work as specified (validation of the
safety function).

6.1. Mechanical Installation

ﬂ No tools are required for installation and deinstallation of the Safety PLC. See sec. 6.1.3 to sec.
6.1.6

Instructions for the installation environment

The device must be protected against impermissible contamination (degree of contamination |l
of IEC 60664-3 must be complied with).

A housing to index of protection IP54, such as a suitable control cabinet will afford the necessary
protection. Operation under conditions of condensing humidity is not permitted.

A WARNING

Potentially hazardous failures due to contamination

Contaminations more severe than those described for degree of contamination Il of IEC 60664-3 may
cause potentially hazardous failures.

» Do ensure that the operating environment complies with at least IP 54, e. g. by installing the unitin a
suitable control cabinet.

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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6.1.1. Installation position

The device is intended for installation on a rail (to DIN EN 50022, 35 x 7.5 mm). Mount the device
on a horizontal rail with the status LEDs of the module facing forwards.

To ensure that enough air enters through the ventilation slots on the module, leave at least 20 mm
to the top and 35 mm to the bottom of the module and any adjacent devices or cabinet surfaces.
Leave at least 20 mm of lateral distance to third-party units and cabinet surfaces.

[
[

20 20

35

Fig. 12: Installation position and minimum clearances in mm

6.1.2. E-bus Plug Connector and Module Lock

The system plug connectors and the module lock are located on the sides of the Safety PLC module.
These plug connectors interconnect the modules. They supply power to the module electronic circuitry
and transfer the EtherCAT signals. The module bus connector together with an end cap to protect the
terminal unit against dirt is attached to the last module at the right-hand side.

The integrated module lock prevents the modules from coming apart under mechanical load or vibration.
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6.1.3. Snapping on a Single Module

Fig. 13: Installing a module

1st  Push the module up against the mounting rail from below, allowing the metal spring to snap
in between mounting rail and mounting area as illustrated.
2nd Push the module upwards against the mounting wall until it snaps in.

6.1.4. Interconnecting two modules

1st  After snapping on the first module to the rail, snap on the second module to the right of the first
module at a distance of about 1 cm.

2nd Push the second module leftwards along the rail towards the first module until you hear the
locking device snap in.

3rd To prevent inadmissible contamination, fit the cover of the module bus connector on to the
rightmost module of the E-1/O system.

A CAUTION

Risk of injury due to short circuit fault of module bus contacts
A short circuit of the module bus contacts may cause the communication with the safe module to fail.
> Make sure that the bus end cap is attached to the last modules of a row of modules.
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6.1.5. Disconnecting two modules

N

Fig. 14: Disconnecting modules

1st  Press the locking device (1) of the module to be disconnected.
2nd Push the two modules away from one another until they are about 1 cm apart.

6.1.6. Removing a single module

N ¢ N *T
A
N N
N & N

Fig. 15: Removing a module
1st Push the module upwards against the metal spring located on the underside of the rail guide.

2nd Tip the module forwards away from the rail as shown in the illustration.
3rd  Pull the module downwards and off the mounting rail.
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6.2. Electrical Installation

6.2.1. Earth

The modules must be earthed, for which purpose the inner metal housing must be connected

to an effective earth conductor. Since the effective earth dissipates HF currents and is of the utmost
importance for the interference immunity of the module.

HF interference is dissipated from the electronics board to the metal housing. The metal housing
therefore needs to be suitably connected to an effective earth.

Normally, earthing of the module housing is provided by a good connection achieved by clicking on to

the DIN rail. This is turn has a good earth connection to the control cabinet, which is itself well earthed.

If necessary the earth can be connected directly to the front of the module (see illustration, item 1).

Fig. 16: Earthing (for example an I/O module)

1

Earth/cable screen attached using a 2 DIN rail connected to an effective earth

M3x5 screw

ﬂ Earth conductors should be short and have a large area (copper mesh).

ﬂ When installing systems, measure the earthing of the DIN rail as specified in the applicable
guidelines (earth test to VDE 0100). Measuring the earthing must show that every protective
earthing and operational earthing are within the limits set by the applicable standards.

»  Perform repeat testing at intervals determined by the risk assessment.

6.2.2. Interconnection between modules

The modules make electrical connections by being completely pushed together. This automatically
connects the modules to both the EtherCAT bus and the system power supply. Refer to section 6.1
Mechanical Installation for details about how to interconnect two modules.

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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6.2.3. System Power Supply to the row of modules

ﬂ Only modules may be used for the power supply to the Safety PLC (bus coupler, microcontrollers in
compliance with EN 61131-2), which provide a reverse polarity safeguard for the 24V power supply.

The logical power supply to the individual modules is provided by the head module (microcontroller
or bus coupler) via the backplane bus of the modules. The number of modules in a row is dependent
on the output power of the head module. A typical output power of 3 A is sufficient to supply

approx. 20 connected modules. To connect a larger number of modules these must be arranged

in multiple blocks, each block with its own bus coupler.

ﬂ > Please comply with the system power supply details provided in the operating instructions of
the upstream bus couplers or compact PLCs as well as the additional system power supply
instruction in this user manual.

»  Please note that the maximum current supplied by the bus coupler limits the number of
modules you may connect to a single block.

ﬂ Depending on the number of modules in the row, the voltage conditions on the E-bus vary
according to the module position.

> Place the Safety PLC module as close as possible to the head module, in order to ensure the
highest possible availability.

A WARNING

Damage due to power supply with the wrong voltage
Supplying the wrong voltages may damage or destroy the unit.
Preventive measures:

»  Only use PELV/SELV-ready power supply units to EN50178 or EN60950-1 to supply 24 VV DC to bus
couplers or compact PLCs to which any Safety PLC modules are connected.

»  Only use the GND terminal to connect the power supply unit to earth (PELV system). Do not use
earthing variants that connect earth to +24 V.

» To ensure that there is as little interference as possible, install a central power supply point and
establish a star topology of as short wires as possible between the central point and the E-I/O
module block.
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6.3. Initial commissioning

ﬂ The Safety PLC may be operated only with FSoE-compliant FSoE slaves.

After any work has been performed on the safety system, the safety functions must be checked for
correct operation.

6.3.1. Configuration

The Safety PLC is configured solely by means of the operating software. There are no configuration
facilities on the module itself.

6.4. Installing the Software

6.4.1. Installing the Safety Extension

The Safety Extension required for the Safety PLC must be integrated manually into the programming
system. After the CODESYS installation has been performed, double clicking on the CODESYS Safety
Extension will install it in the installation file.

Alternatively the extension can be installed in the CODESYS itself under the "Tools -> Package
Manager... -> Install...“ tab.

Tools | Window Help Name v} { Install... ]
{ @ Package Manager... o
m Library Repository... e required
1 I’] Device Repository... e required
) o] Visual Element Repository | Updates

&l Visualization Styles Repository... ’ Search updates

Important: In both cases the installation of the extension must be performed by a user with
administrative rights.

»  On completion of the installation, restart the CODESYS programming system.
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6.4.2. Installing the Safety Device Description

It is a condition of use of EtherCAT modules that the associated device description is installed.
This applies also to safety modules (Safety PLC and associated I/O modules).

Device descriptions (*.xml) can be installed in CODESYS under the "Tools -> Device Repository* tab.

(e
v ‘ Edit Locations...

'Iools \ Window Help Install...

« 3 Package Manager...
m Library Repository...

\ U_j Device Repository... o

1 — Install DTM...
@ Visual Element Repository

The device description for the Safety PLC and descriptions for all other devices must be installed
in the device repository before they can be used in the project.

ﬂ The installation of CODESYS Package files and device descriptions should always be performed by
a user with administrative rights.
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6.4.3. Creating a safety project

1st Open CODESYS V3.

2nd On the Standard CODESYS home page, under “Basic operations” click on “New project...".

Start Page X
@9 CODESYS V3.5 SH

Basic Operations

|£] New Project...

i

@ Open Project...

Alternatively you can create a new project under “File -> New project...“.

o CODESYS
File | Edit View Project Build
=] NewProject...  Ctrl+N

]

@ OpenProject... Ctrl4+0

] Close Project

Save Project Ctrl+5

3rd  Select the template “Empty safety project".
4th  Select "Name* and the memory location of the project, and press "OK* to create the project.

7

_] New Project .
Categories: Templates:
{_ Libraries
& ® ¢

Empty project Empty Safety project

Standard project  Standard project with
Application Composer

A project containing one device, one application, and an empty implementation for PLC_PRG

5th  For an empty project, attach a standard PLC by right clicking on "[project name] -> Attach
device®.

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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@ E Properties... —

%1] Add Object »
i) Add Folder...

Edit Object

Edit Object With...

Edit IO mapping

Device Configuration »

6th  Select the device type of the desired standard PLC.

-

Add Device

Name: [ ]
Action:

@ Append device Insert device Plug device Update device

Device:

Vendor: [<AI vendors> -

Name Vendor  Version
#-[@ Logical devices
+ [@ pLcs

Group by category
Display all versions(for experts only)
Display outdated versions

7th  In order to insert objects into the application, right click on "Application -> Add Object” to execute

it.
Corste 00
=13 Demo
= (43 Device (CODESYS Control Win V3)
= (8 sps-Logi

= Application

A list opens, in which all objects available to be added are shown.
Clicking on the respective object adds it to the application.
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=-E10 pLC Logic
= | Applica: —
m Librg % cut
(@ mternal_1_0 Copy
Paste
X  Delete
Properties...
3 Add Object » I Alarm configuration...
) AddFolder... Data Server...
[ EditObject DUT...
Edit Object With... External File...
q Login Global Variable List...

Image Pool...
Interface...

Logical Exchange GVL...
Logical I/Os...

Persistent Variables...

Network Variable List (Receiver)...
Network Variable List (Sender)...

<o ien S

8th Inserting a POU (program).
9th Inserting a task configuration.
10th Use the task configuration to call up POU:

Click on “Add call up® and select POU in the list.

Devices ~ % X|| ‘g Task x[[] CODESYS_Controlinv3 |
- '@ Dema )| Configuration
= [ coDEsYS_Control_Win_V3 (CODE
= &l PLC Logic
= o Application Priority { 0..31 ): 1]

=m Library Manager

POU (PRE)

- @ Task Configuration
=g Task

48 pou

Time (e.g. t#200ms):

Sensitivity: 1

dh Add Call ‘¥ Remove Call [ Change Call

Type

Interval (e.g. t£200ms): J2000]
Watchdog

[T]Enable

#+ MoveUp # Move Down

= Open POU

POU
POU

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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Since the Safety PLC is an EtherCAT-based module, an EtherCAT master must also be attached:
11th Right click on the standard PLC already selected.
12th Select "Attach device...” in the selection window.
Devices * 1 é] g Task x| ] CODESYS_Control_Win_V3
=3 Demo Configuration
= 1] |copesys_contral_wi 4 g
=Bl PLC Logic hocut
=1} Application Copy
m Library M; Paste
POU (PRE . Delete
= @ Task Con
= Task
Hr Properties...
7  Add Object »
) AddFolder...
| Add Device...

.g. t%2

Browse 4

Update Device...
Edit Object
Edit Object With... ge Cal

L

13th In the next window select “Field buses -> EtherCAT -> Master -> EtherCAT Master*.
14th Click on “Attach device® to insert the EtherCAT master into the project.

[} Add Device

Name: EtherCAT_Master
Action:

@ Append device

Device:

Vendor: [ <All vendors >

Name
= \_|_j Fieldbusses
+- AN CANbus
= a;a.} EtherCAT
= Dﬁj Master
|_|_:‘] [ EtherCAT Master

The EtherCAT master is now listed in the device window and has been successfully incorporated into
the project. The associated task configuration for the EtherCAT master is also created automatically.
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[ Demoproject” - coBESE N

File Edit View Project Build Online Debug Tools Windo

BeH & dh £ ]|
Devices - 0 X
=3 Demo E
=[] copEsYs_Cantrol_Win_v3 (CODESYS Control Win V3)
=-El) PLC Logic

=} Application
m Library Manager
POU (PRG)
= @ Task Configuration
=38 EtherCAT Master
] EtherCAT_Master.EtherCAT_Task
= @ MainTask
& rou

[ EtherCAT Master (EtherCAT Master)

15th In the settings for the EtherCAT master, select or declare the associated Ethernet interface.
(EtherCAT NIC settings - Select the network by name, network name)

[{] etherCAT_Master x

General AutoconfigMaster/Slaves Ethercn"f%
Sync Unit Assignment EtherCAT NIC Setting
EtherCAT /O Mapping Destination Address{MAC) |FF-FF-FF-FF-FF-FF Broadcast  [] Enable Redundancy
Source Address (MAC) 00-00-00-00-00-00
Status
Network Name ethl
Infarmation (7 Select Network by MAC @ Select Network by Name
Distributed Clock Options
Cycle Time 4000 ps

E1LAG] L

Sync Offset 20 25

|:| Sync Window Monitaring

Sync Window 1 ~ ps

16th Inserting EtherCAT devices manually or by EtherCAT search.
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Installing EtherCAT devices manually

The bus coupler, Safety PLC, safety modules and other EtherCAT modules can now be inserted from
the point of view of the standard PLC:

1st Right click on "EtherCAT_Master -> Attach device... .
2nd Select devices.

Devices > 1% @
=gl Demo =
=[]l coDESYS_Control_win_y3 (CODESYS Conrol Win V3) Gen
=-Ell PLC Logic
=i} Application Sync
m Library Manager
POU (PRG) ELE

= @ Task Configuration
= 38 EtherCAT_Master
) EtherCAT_Master EtherCAT Task]

Stati

Info
= @ MairTask
& pou
|7 |EtherCAT_Master (EtherCAT Master}
% cut
Copy
Paste
P Delete
Browse L4
Refactoring 3
Properties. ..
! Add Object
) Add Folder...
Add Device...
Insert Device. ..
Scan For Devices...
Devices > R X | [f] EtherCAT Master x|
=g Demo [ Add Device
=l cODESYS_Control_win_v3 (CODESYS Cf
-8l PLC Logic Name: E_I_O_Safety PLC
=1} Application
m Library Manager REITE
POU (PRG) @ Append device (7) Insert device
= @ Task Configuration
= @ EtherCAT Master Enter a string for a fulltext search in all devices...
| EtherCAT_Master.B Name !
=& MairTask +- [ Feldbusses
& pou = [ pLcs
=[]l EtherCAT Master (EtherCAT Mastef = () safety PLcs
@ E_I_0O_Buskoppler (Buscoupler ﬂj |SaFety PLC (204 909 000) | £
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Insert devices by EtherCAT search

As an alternative to manual insertion, there is also an easy way to link modules into the project.
Available EtherCAT devices can be sought automatically and inserted into the project. For this purpose
an executable and compilable application must exist with the EtherCAT master on the standard PLC.
In addition all desired additional modules must be connected.

1st  Right click on "Application-> Login“ to login to the standard PLC.
2nd Load the application to the PLC.
3rd Right click on "EtherCAT_Master -> Search for devices...” to open a new window for the search.

TR
= (A [E4harr AT Mactar [EthartAT M rtar)

& cut 204 80
Copy

Paste

¥ Delete
Browse 3
Refactoring >
Properties. ..
Add Object
) Add Folder...
Add Device...

Insert Device...

Scan For Devices...

Disable Device
Update Device...
Edit Object

Edit Object With...

L

After the search process, all devices found within the EtherCAT network are listed.

Scan Devices

Scanned Devices

Devicename Devicetype Alias Address
T Buscoupler (204

o e W R =

[7] Show €

4th  Click on “Copy all devices into project” to automatically add all devices found under the EtherCAT
master.
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o] LUISIGM L _Masie L e _asn
=[] EtherCAT_Master (EtherCAT Master)
= m E_I_O_Buskoppler (Buscoupler (204 800 000))
= ﬂj SafetyPLC (Berghof EIQ Safety PLC)
= @1] Safety Logic
=0} SafetyApp
m Library Manager
= ﬂj Logical Ij0s
[ vFio_s14_502 [<-VFIO_SI4 SO
[ vFIO_514_502_1 [<-VFIQ_SI4 ¢
8 safety Task
= m E_I_O_Buskoppler_1 (Buscoupler {204 800 000))
= vF10_514_502 [->VFIO_514 502] (VFIO SI4/50
[ Fs0ES (VFIO S14/502 (594.430.00))
= vF10_514_502_1 [->VFIO_5I4 502_1] (VFIO 5I
[ FsoES_1 (VFIO 514/502 (594.430.00))
[ E_1_0_DI16_DO16 (DI16/D016 1ms 0.5A (204 &

The safety application is located in the EtherCAT module of the Safety PLC. This is used within
the programming system as a “normal” standard PLC (set active application, login, logout).

ﬂ For creation of the safety application see the CODESYS Safety Manual.

When an empty safety project is created, a user management is always incorporated automatically.

By default this is the user as the “Owner®, with a blank password.
When changes are made to a safety application the user must be authenticated so that the change
can be made.

[ Logon Iﬁ

In arder to perform this action, you must logon as a user which is
member of one of the following groups:

Owner
Safety.ExtendedLevel

Please enter your user name and password:

ProjectfLibrary: Project: Testapp-5Y5-1

User name:

Password:

OK Cancel

ﬂ Safety devices and safety applications should generally be password-protected against

unauthorised access
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6.4.4. Safety PLC -logging in and downloading an application

In order to create a connection to the Safety PLC, an EtherCAT master with the correct EtherCAT
configuration must be present and started on the standard PLC, so that the EtherCAT master is running.

1st Inthe logged in state, right click on "Safety App“-> “Active application to switch the active
application to the Safety PLC.

e e 2 =y
= m Berghof_MX6&_Control [connected] (Berghof MX& Control)
=1 PLC Logic
+ I} Application [run]
=43 [i] EtherCAT_Master (EtherCAT Master)
= m E_I_O_Buskoppler (Buscoupler {204 800 000))
= ﬁ E_I_O_Safety_PLC (Safety PLC (204903 000))
=B safety Logic
=% |safetyApp 5¥S 1 ]
m Library & cut

= m Logical Copy

(i Log Paste LC1]
(@ o . Delete m3PL)
@ v /502
@ v Browse Y haa
@ NotHall (=) Properties...
@ Tnoba Add Object 3
& safery| 22 =t
= Safety
- m E I 0 Buskoppler_1/=) Add Folder...
=3[ vrIo_s14.s02[ [] Edit Object 0.00
(i Fsoes (1 Edit Object With. ..
= #3 [ vrio_s14 s02_ _ — 4,43
ﬁj FAOES 1[\J| Set Active Application

[ e1_o_pr1s pd @8 Legn

Delete application from device

2nd Right click on "Safety App“->“Login“ to log in to the Safety PLC.
3rd Load the application to the PLC.

= @l] Safety Logic

=03 %{ﬂ!@g ) ol out
Library Man
By co
= ﬁj Logical 1/0s = F
ﬂj Logical_ Paste
[ Logical | % Delete |
ﬁ VFIO_S Browse »
A vrio_s 3 .
@ NotHalt1 = Properties...
[#] TwoHand1 |3y Add Object ’
 safety Task () add Folder...
m E_I_O_Buskoppler_1 {Bu: _‘T Edit Object
=37 vFIO_S514_502 [->VF
S
ﬁj FSOES (VFIO SI4 Edit Object With...
= 3 vFIo_514_502_1 [-3 98 Login
ﬂj FSOES_1 (VF1O Delete application from device

[ E_1_0_DI16_DO1E (brroyooro s wromg
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At logging in, a security question requests the serial number of the Safety PLC. The ensures that
a Safety PLC and the application on it will not be changed inadvertently.

Connect to safety device ﬁ

Device object: E_I O_safety PLC
Device type: E-I/0 Safety PLC
Device name: E-1/0 Safety PLC

Flease select the connection type and confirm to connect to the safety device.

@ Confirmed Connection

Please enter serial number

Instance identification:

[ oK ][ Cancel J

4th  Right click on "Safety App“ -> Start to start the application.

=3 [] EtherCAT_Master (EtherCAT Master)
= m E_I_0O_Buskoppler (Buscoupler (204 800 000))
= m E_I_O_safety PLC [connected] (Safety PLC (204 909 000))
= @[l Safety Logic
- i safetyApp SYS 1 [<tonl
m Library Manager nxn Cut
= m Logical Ij0s Copy

ﬂi Logical_exch Paste
ﬂi Logical_exch T
A vFro_s14. s
(A vFro_s14. s Browse v
@ MotHaltl = Properties...
@ TwoHand1 e — R
_— ¥ ec
@ Safety Task _I 2
=3 [ E_1_0_Buskoppler_1 (Buscou] = Add Folder...
= ﬁ VFIO_SI4_S02 [-=VFIO_ _'T Edit Object

(A FsoEs (vFIO 514/50 Edit Object With...
=237 vFI0_s14_S02_1 [->VFIQ
- T ﬁ Logout
[H FsoEs_t (vFIO 514/=
[ E_1_o_p115_DO16 [D116| HEE

-

Delete application from device
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6.4.5. Safety PLC — FSoE (Safety over EtherCAT)

The Safety PLC communicated via FSoE (Safety over EtherCAT) with other safety modules. For this
purpose the Safety PLC is the FSoE master and the safety modules are FSoE slaves. The FSoE
slaves are addressed by the master via a unique ID. This FSoE slave ID must be unique within the
EtherCAT network and configured both in the master and also in the slave module. (Refer to the User
Guide for the respective module for the procedure for setting the FSoE ID in the slave module)

6.4.6. Configuration of the FSoE slave ID in the Safety PLC

The FSoE (Safety over EtherCAT) slave modules are configured in the Safety PLC using
CODESYS Safety.

=[] EtherCAT_Master (EtherCAT Master)
= m E_I_O_Buskoppler (Buscoupler {204 800 000))
= ﬁ SafetyPLC (Berghof EIO Safety PLC)
= @1] Safety Logic
=} safetyApp
m Library Manager
= m Logical Ij0s
(i [vFro_st4_so2 [<-vF10_s14_s0:
@ vFIO_SI4_502_1 [<-VFIO_S14_S
£ safety Task
= m E_I_0O_Buskoppler _1 (Buscoupler (204 800 000))
=-[[ vFI0_514_502 [->VFIO_S14 502] {VFIO 5I4/50
[ Fs0ES (VFIO 514/502 (534.430.00))
=@ vFI0_514 502_1 [->VFIO_SI4 502_1] (VFIO ST
(M FsOES_1 (VFIO S14/502 (594.430.000)
[ E_1_0_DIi6 D016 (DI16/DO1E ims 0.5A (204 80

The FSoE configuration of the slave modules is performed in the Safety PLC under the "Safety App“ in

the logical 1/Os entry. Here the slave modules are inserted automatically and can be modified manually.

The configuration of the respective FSoE slave must be saved in the configuration window.
Each module must here be assigned a unique FSoE address and a unique connection ID.

(7] vFio_s1a_so2 x

Safe configuration In Work

MName Value

0 mappin
u Hi FSoE address 1

Information Connection ID ;

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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6.5. Validation of the safety function

On completion of the installation and commissioning the safety application, this must be validated for
correct operation within the overall system.

A DANGER

Validation of the safety function
Safety applications must be validated for implementation and function within the overall system.

»  Perform and document validation of the overall system as specified in the CODESYS Safety User
Guide
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6.6. Diagnostics

6.6.1. Selftest

When system voltage is applied to the Safety PLC, initially the module runs a complete system test.
Only once the module has passed the self-test can the module be used. Only once this is done does
the Safety PLC switch into the "Fail-Safe" safe state.

This is indicated by the "Safe Status” LED lighting up red.

The Safety PLC will remain in the fail-safe state until all internal tests have been passed.

Once the Safety PLC has passed the self-test the safety application saved on it is started.

This is the safe functional state is indicated by LED "Safe Status" lighting up green.

If the state is not achieved, for instance if it was not configured correctly in the application — the module
still remains in the fail-safe state.

In service, the system test is repeated cyclically as a background process; any faults found the self-test
also trigger the Fail-Safe state. This is recorded in the CODESYS log.

6.6.2. Faults within the Safety PLC module

Faults within the Safety PLC module will be discovered in good time by the cyclic system test in
accordance with the requirements of the standards specified in the certificate, and will result in a switch
to the Fail-Safe state.

The Fail-Safe state is indicated by the LED "Safe Status" lighting up red (see section 5.3 Status LEDs).

ﬂ The status LEDs are not safety-related displays. Thus the displays of the status LEDs must not be
relied on as a reliable indication of the operating status of the module etc.

Aoawesr

Use of devices in a fail-safe state
The following faults may provoke a hazard.

»  On your own responsibility, ensure that after a fault occurs, all necessary measures are taken for
clarification and rectification of the cause of the fault, and components are replaced as necessary.

ﬂ In case of serious internal faults within the module of the Safety PLC, Berghof Automation GmbH
must be informed.
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6.6.3. Temperature Faults

The module is designed for ambient temperatures between 0 °C and max. 55 °C and to be installed in
a control cabinet. The Safety PLC incorporates its own internal temperature sensor. If during operation
the temperature strays outside the specified range, the Fail-Safe state will be adopted. If the ambient
temperature is outside the specified temperature range, the module cannot be brought into operation.

A CAUTION

It is prohibited to operate the FIO Safety /O module outside the specified range
Faults due to undertemperature / overtemperature.

»  The module may be operated only under the ambient conditions listed in the Technical Data.

A CAUTION

It is impermissible to use the internal temperature sensors for safety applications!
Temperature sensor not available for safety-related applications.

»  The internal temperature sensor may not be used for implementation of safety applications.

6.6.4. Error Handling and Logging

Depending on their type, faults detected are indicated by the diagnostic LEDs of the Safety PLC.

In addition all error messages are displayed in the log-window of the respective Safety PLC in the
programming system. Furthermore, the errors can be read by the standard PLC from special tabs of
the Safety PLC by using COE objects (see the index of objects).
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6.7. Resetting/acknowledging an error

The Safety PLC makes a distinction between errors in the Safety PLC and those in the communication
with sensors and actuators and faults of the sensors and actuators.

Errors in the Safety PLC can be acknowledged only by restarting the system. This is achieved by
performing a power cycle (switching the power off and on again) at the head module.

Loss of communications or faults in sensors and actuators lead to errors in the associated safety
module. They are detected in the safety application and acknowledged by rest procedures at the
modules (such as the FSoE master). In this case the Safety PLC remains in the functional safe state.

Power Cycle
After the cause of the fault has been rectified the Safety PLC can be reset by performing a power cycle
(switching the power off and on again) at the head module.

A WARNING

Resetting / acknowledging may cause a dangerous state
»  Before acknowledging an error, verify that its cause has been removed professionally.

»  Before acknowledging an error, verify that acknowledging it will not cause a dangerous machine
state.

» At the machine or system planning stage, make sure that acknowledging an error must not be
possible unless you have full view of the danger zone.

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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6.8. Maintenance / Servicing

6.8.1. General

Only qualified persons are allowed to work on the Safety PLC.

A CAUTION

Unsafe and undefined machine state

Destruction or malfunction of the Safety PLC.

»  The module housing may not be opened.

»  The module may not be repaired.

» Do not plug, mount, unplug or touch the connectors during operation!
4

Switch off all power sources before working on the modules. This also applies to any peripherals
such as encoders or programming devices with external power sources, etc.

> Check that none of the ventilation slots is covered.

6.8.2. Servicing

The Safety PLC Module is maintenance-free for the specified service life, and requires no servicing.
For this reason there are also no spare parts available.

Whilst in operation and storage the Safety PLC must be protected against contamination, apart from the
degree of contamination usually expected in the defined ambient conditions of use. If the module if it has
been exposed to inadmissible contamination, do not attempt to use it, clean it or continue to use it.

A DANGER

Risk of injury due to safe and undefined machine state
»  Operation of an impermissible contaminated module is prohibited.
»  Cleaning the unit is prohibited.
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6.9. Replacement of a Safety PLC

A CAUTION

Risk of injury due to safe and undefined machine state

Risk of injury.

»  Switch off the power supply to the Safety PLC and the connected modules before replacing a Safety
PLC module.

»  Once a Safety PLC module has been replaced, separately test the safety function before restarting
the machine or system.

6.9.1. Replacement

Preparation
1st Ensure that the new module satisfies the following conditions:
->  Same type of device
-  The same or higher version, see section 5.1 Labelling and Identification.
2nd Bring the system or machine into a safe state.
3rd  Switch off the power supply to the head module and the connected modules.

Remove the old module

4th  If necessary, separate the row of E-I/O modules: Press the locking device of the adjoining
module and push the two modules away from one another until they are about 1 cm apart
(see the user guide for the other module).

5th  Push the module upwards against the metal spring located on the underside of the rail guide.
(see section 6.1.6 Removing a single module).

6th  Tip the module forwards away from the rail.

7th  Pull the module downwards and off the mounting rail.

Installing and programming the new module

8th Install the substitute module at the same place within the row of FIO modules as the one that
was removed (see section 6.1.3 Snapping on a Single Module).

9th Load the validated safety application.

6.9.2. Recommissioning

1st  Ensure that the machine or system is in a safe state and that there is nothing and nobody in the
danger zone.

2nd  Switch the supply voltage on again.

3rd  After the replacement safety module has been plugged in, proceed as for initial commissioning
(see section 6.3 Initial commissioning).

4th  After replacing a module, perform a check of all safety functions.
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6.10. Working Life

Safety PLC Modules have a design life of max. 20 years from their date of manufacture (see section
5.1 Labelling and Identification).

A WARNING

Risk of injury if modules are used beyond their useful life!

»  Take the module out of use no later than expiry of its useful life (see section 6.10.3
Decommissioning).

6.10.1.Repairs / Customer Service

It is prohibited to open or try to repair a Safety PLC Module. In such an event the function of the Safety
PLC Module can no longer be guaranteed.

ﬂ If a module failure is potentially hazardous, return the module to the manufacturer where the fault
will be identified.

For the manufacturer’'s address see section 8 Customer Service / Addresses.

6.10.2. Warranty

The statutory warranty is applicable. It lapses if the device/product is subjected to unauthorised
attempts at repairs or other interventions.

6.10.3.Decommissioning

The manufacturer of the machine or system specifies the procedure for decommissioning the product.

> During decommissioning, ensure that the used modules of the Safety PLC Module are presented
for further use for the intended purpose.

> Comply with the transport and storage requirements specified in the Technical Data.

6.10.4.Disposal

> Dispose of the safety system in conformity with the applicable environmental regulations and
make sure that it is not returned into circulation.
> Treat the packaging as recyclable paper and cardboard.
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7. Appendix

7.1. Safety-related Output Ratings of the Safety PLC

The following table contains the safety-related output ratings of the Safety PLC. All components
involved in the safety function must be taken into account in order to assess whether the desired safety

level is achieved.

Maximum safety integrity level to EN SIL3
62061:2010

Maximum safety integrity level to IEC SIL3
61508:2010

Maximum performance level to EN ISO Cat. 4/PL e
13849-1:2015

Hardware fault tolerance HFT (IEC 1

61508:2010/
EN ISO 13849-1:2015)

Probability of failure on demand PFDayg
proof test interval: 20 years, (IEC
61508:2010)

(a fault of the application need not cause the safeguard to

fail)

Ambient temperature 25

°C

2.57*10°
(2.57 % of the total PFDavg
of 102 at SIL3)

Ambient temperature 55
°C

2.99*10°
(2.99 % of the total PFDavg
of 102 at SIL3)

Probability of failure on demand PFHyg,
proof test interval: 20 years, (IEC
61508:2010)

3.04 *1091/n
(0.3 % of the total PFDayg Of
1077 at SIL3)

3.55*1010 1/h
(0.36 % of the total PFDavg
of 10~ at SIL3)

DC (diagnostic coverage) to EN ISO
13849-1:2015

97.24 %

(rounded up to 99%

in accordance with EN ISO
13849-1:2015)

96.9 %

(rounded up to 99%

in accordance with EN ISO
13849-1:2015)

Safe failure fraction (SFF)

98.6 %

98.49 %

MTTFp to EN ISO 13849-1:2015

225 years

221 years
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7.2. Communications objects

7.2.1. Device Type 1000

Name Device Type
Index 1000n

Object Code VARIABLE
No. of Elements 0

Data Type UNSIGNED32
Access Read only
PDO Mapping no

Value Range Set

Default Value 89130000n

7.2.2. Error Register 1001n

Name Error Register
Index 1001n

Object Code VARIABLE
No. of Elements 0

Data Type UNSIGNEDS
Access Read only
PDO Mapping No, TX-PDO
Default Value 00n

Bit evaluation to CANopen DS301:

Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0
0x80 | 0x40 | 0x20 0x10 0x08 0x04 0x02 0x01
n.u. n.u. n.u. n.u. Temperature Wrong supply n.u. Other faults
faults voltage
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7.2.3. Device Name 1008n

Name Device Name
Index 1008n

Object Code VARIABLE

No. of Elements 0

Data Type VISIBLE_STRING
Access Read only

PDO Mapping No

Value Range Fix

Sub-index 0 of this object contains the string length. Sub-index 1 contains each of the characters.
The character string has no terminating zero.

7.2.4. Hardware Version 1009n

Name Manufacturer Hardware Version
Index 1009n

Object Code VARIABLE

No. of Elements 0

Data Type VISIBLE_STRING

Access Read only

PDO Mapping No

Value Range Fix

Default Value 12E3030+ (1.00)
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7.2.5. Software Version 100An

Name Software Version
Index 100An

Object Code VARIABLE

No. of Elements 0

Data Type VISIBLE_STRING
Access Read only

PDO Mapping No

Value Range Fix

Default Value 1.2.0

7.2.6. CANopen ‘Restore default parameters obj. 1011

Name CANopen ,Restore default parameters’ obj.
Index 1011n

Object Code RECORD

No. of Elements 5

Name Number of entries

Subindex 00n

Data type UNSIGNEDS8

Access Read only

PDO Mapping No

Default Value No default

Name Restore all parameters (not used)
Subindex 0ln

Data type UNSIGNED32

PDO Mapping No
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Value

Name Restore communication parameters (not used)
Subindex 02n

Data type UNSIGNED32

PDO Mapping No

Name Restore application parameters (not used)
Subindex 03n

Data type UNSIGNED32

PDO Mapping No

Value

Name Restore file system
(write 0x64616F6C; comes into effect on next power cycle; request
will be cleared after 1 min if no power cycle occurs)

Subindex 04n

Data type UNSIGNED32

Access Read write

PDO Mapping No

Value

Name Delete Boot Application
(write O0x64616F6C; comes into effect on next power cycle; request
will be cleared after 1 min if no power cycle occurs)

Subindex 05n

Data type UNSIGNED32

Access Read write

PDO Mapping No
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7.2.7. ldentity Object 1018n

Value

Name Identity object
Index 1018n

Object Code RECORD

No. of Elements 4

Data Type IDENTITY
Name Number of entries
Subindex 00n

Data type UNSIGNEDS
Access Read only
PDO Mapping No

Default Value 4

Name Vendor-ID
Subindex 0ln

Data type UNSIGNED32
Access Read only
PDO Mapping No

Designation

Value

Name Product Code
Subindex 02n

Data type UNSIGNED32
Access Read only
PDO Mapping No
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Name Revision

Subindex 03n

Data type UNSIGNED32

Access Read only

PDO Mapping No

Name Serial number

Subindex 04n

Data type UNSIGNED32

Access Read only

PDO Mapping No

Units YYYYYY mmmm ddddd nnnnnnnnNNnNnnNNNnn
6-bit 4-bit 5-bit 17-bit

Year 2014 is coded as '0'.

Value Range 14 01 01 00001 (0x00420001) ...
77 12 31 99999 (OxFF3F869F)

Example 16052300001 <> 0x096E0001

The object contains details of the manufacturer, the product code and the revision and serial number.
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7.2.8. Error Settings (not used) 10F1n

Name Error Settings (not used)
Index 10F1n

No. of Elements 0

Access Read only

PDO Mapping No, TX-PDO

7.2.9. Sync Manager Type (not used) 1C00n

Name Sync Manager Type (not used)
Index 1CO00n

No. of Elements 0

Data Type UNSIGNEDS8

Access Read only

PDO Mapping No

7.2.10.SM out par (not used) 1C32n

Name SM out par (hot used)
Index 1C32n

No. of Elements 0

Data Type UNSIGNEDS

Access Read only

PDO Mapping No
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7.2.11.SM in par (not used) 1C33n

Name SM in par (not used)
Index 1C33n

No. of Elements 0

Data Type UNSIGNEDS
Access Read only

PDO Mapping No

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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7.3. Manufacturer-specific objects

7.3.1. MC 1: Reference Voltage [mV] 2000n

Name MC 1: Reference Voltage [mV]
Index 2000n

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED16

Access Read only

PDO Mapping No

Units mV

Value Range 0...65535

Default Value No default value

7.3.2. MC 1: 5V Supply Voltage [mV] 2002h

Name MC 1: 5V Supply Voltage [mV]
Index 2002n

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED16

Access Read only

PDO Mapping No

Units mV

Value Range 0...65535

Default Value No default value
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7.3.3. MC 1: 3.3V Supply Voltage [mV] 2003h

This is the supply voltage to MC 2 as measured by MC 1.

Name MC 1: 3,3 V Supply Voltage [mV]
Index 2003n

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED16

Access Read only

PDO Mapping No

Units mV

Value Range 0 ... 65535

Default Value No default value

7.3.4. Temperature sensor [0.01°C] 2006n

Name Temperature sensor [0,01°C]
Index 2006n

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED16

Access Read

PDO Mapping No

Units 0,01°C

Value Range 0 ... 8000

Default Value No default Value
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7.3.5. MC 1: Error code 2007h

Name MC 1: Error code
Index 2007h

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED32
Access Read

PDO Mapping No

The table below explains the entries in object 2007 "error code".

OK No error
0x0000
No error
HWT PARAMETER_ERROR
1 0x0001 - -
Hardware test parameter error
2 OX0002 HWT_INIT_ERROR

Hardware test initialisation error

100 0x0064 HWT_MEM_MARCHC_ERROR
Hardware test RAM check error

101 0x0065 HWT_MEM_GALPAT_ERROR
Hardware test RAM check error
HWT _STACK_UNDERFLOW_ERROR

200 0x00C8 - - -
Hardware test stack underflow
HWT STACK_OVERFLOW_ERROR

201 0x00C9 - - -
Hardware test stack overflow

300 OxO12C HWT_CPU_ERROR

X Hardware test CPU error

WT_FW_ERROR

400 0x0190 - i
Hardware test firmware error
HWT FWINTERFACE_ERROR

500 Ox01F4 - X -
Hardware test firmware error
HWT_ADC_ERROR: Test handler: error in ADC value range checks

504 Ox01F8
Hardware test AD converter error

505  OXO1F9 HWT_DMA_ ERROR: Test Handler: error in DMA check

X Hardware test DMA checksum error

HWT_ CRC_ERROR: Test Handler: error in CRC check

506 Ox01FA - -

Hardware test CCRC checksum error
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_ Hex Explanation
507 OXOLFB HWT_TIMER_ERROR: Test handler: error in timer check
X Hardware test CPU timer error
508  OXOLEC HWT_CLOCK_ERROR: Test Handler: error in clock signal check
X Hardware test CPU clock error
512  0x0200 TIMEOUT_ERR: Timeout detected.
X Software timeout detected
OUT_OF_RANGE_ERR: Parameter or value out of allowed range.
513 0x0201
Parameter range error
OVERWRITE_ERR: Register buffer data overwrite occurred.
514 0x0202
Data overflow occurred
PRG_CNTRL_ERR: Program sequence control detected error.
516 0x0204 .
Program execution error detected
517  Ox0205 “Soft-Error” detected
X Software error detected
INIT_ERROR: Initialisation error
528 0x0210 L
Initialisation error
ASSERT_TRUE_ERR: Assertion for expression yields "true" failed.
592  0x0250 . e
Assertion for "true" failed
ASSERT_NOT_NULL_ERR: Assertion for unequal to NULL failed.
593 0x0251 . .
Assertion for unequal to NULL failed
ASSERT_GE_ERR: Assertion for ">=" comparison failed.
594  0x0252 . o . .
Assertion for ">=" comparison failed
ASSERT_GT_ERR: Assertion for ">" comparison failed.
595 0x0253 . o . .
Assertion for ">" comparison failed
ASSERT_LE_ERR: Assertion for "<=" comparison failed.
596 0x0254 . . g
Assertion for "<=" failed
ASSERT_LT_ERR: Assertion for "<" comparison failed.
597 0x0255 . . g
Assertion for "<” failed
ASSERT_NE_ERR: Assertion for "<>" comparison failed.
598 0x0256 . .
Assertion for "<>" failed
ASSERT_EQ_ERR: Assertion for "=" comparison failed.
599 0x0257 . .
Assertion for "=" failed
ASSERT_FALSE_ERR: Assertion for expression yields "false" failed.
600 0x0258 . .
Assertion for "false" failed
672  OXO2AQ MRAM is not initialized
X MRAM is not initialized
673  OX02AL MRAM_READ_ ERR: MRAM Read error.
X MRAM read error
MRAM_CORRUPT_PAGE_SIZE: MRAM invalid page size.
676 0x02A4

MRAM page size error
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_ Hex Explanation

MRAM_CRC_ERR: MRAM data CRC check failed.

677 0x02A5 MRAM checksum error (CRC error)
688 0x02BO LZS logging is not initialized yet.
689 0x02B1 LZS logging is initialized.
692 0x02B4 LZS world time timer has been initialized.
696 0x02B8 Request file system reset.
697 0x02B9 Request deleting boot app from file system.
698 0x02BA Boot app deleted from file system.
699 0x02BB Reset of file system activated.
700 0x02BC System request cancelled due to timeout.
RESET_LOW_POWER: Reset due to low power supply.
768 0x0300
Reset due to undervoltage
RESET_WINDOW_WD: Reset due to window watchdog.
769 0x0301 )
Reset due to window watchdog
RESET_INDEPENDENT_WD: Reset due to independent watchdog.
770 0x0302 .
Reset due to watchdog timer
RESET_SW: Reset due to software reset.
771 0x0303
Reset due to software reset
RESET_POWER_ON_DOWN: Reset due to power up or down.
772 0x0304 L o
Reset due to switching on or switching off
RESET_NMI: Reset due to non-maskable interrupt.
773  0x0305 .
Reset due to non-maskable interrupt
774 OX0306 RESET_BROWNOUT: Reset due to brown out detection.
X Reset due to CPU undervoltage
RESET_NO_REASON: Reset due to unknown reason.
775 0x0307
Reset for no known reason
Reset due to invalid reason
778 0x310

Reset due to invalid reason

ADC_REF_LOW: Reference voltage too low.

1024  0x0400
X AD converter reference voltage too low

ADC_REF_HIGH: Reference voltage too high.

1025 0x0401 .
X AD converter reference voltage too high

ADC_5V_LOW: 5V supply voltage too low. (ErrReg: 4)

1028 0x0404 5V load power supply below the tolerance range

ADC_5V_HIGH: 5 V supply voltage too high. (ErrReg: 4)

1029 0x0405
X 5V load power supply above the tolerance range

ADC_3_3V_LOW: 3,3 V supply voltage too low.

1030 0x0406
X Internal 3.3V power supply below the tolerance range

1031 0x0407 ADC_3_3V_HIGH: 3,3 V supply voltage too high.
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_ Hex Explanation

Internal 3.3V power supply above the tolerance range

ADC_TEMP_LOW: On-chip temperature too low. (ErrReg: 8)
1032 0x0408 :

Ambient temperature too low

ADC_TEMP_HIGH: On-chip temperature too high. (ErrReg: 8)
1033 0x0409 : .

Ambient temperature too high

ADC_CURR_HIGH: Total output current too high. (ErrReg: 2)
1034 0x040A .

Total output current too high

Temperature reached warning limit

1036 0x040C o
Temperature reached warning limit
Data value not yet available

1037 0x040D .

Data value not yet available
LINE_TIMEOUT: Invalid sync line level from base board

1280 0x0500 L ) L
Synchronisation wire level monitoring timed out
TIMEOUTTIMERERR: Timeout occurred

1282 0x0502 . .

Timeout timer error
HW_REVISION_ERROR: Invalid HW revision detected (the SW currently
running is not designed for this HW revision)

1283 0x0503 . L .
Incorrect hardware / PCB revision (the SW currently running is not designed for
this HW revision)

MC1_NOTREADY: MC1 has not yet initiated communication to MC3

1664 0x0680 o L
MC1 has not yet initiated communication to MC3
BCOM_NOTREADY: Communication to base board not ready / operational

2048 0x0800 L .

Base-board communication not ready / operational
BCOM_BUSY: Communication to base board is busy

2049 0x0801 L
Base-board communication overloaded
BCOM_NONEWDATA: No new data received from base board

2050 0x0802 L .

Base-board communication — no new data received
BCOM_CRCERR: Communication to base board detected a CRC error
2051 0x0803 .
Base-board communication — checksum error detected
2052  Ox0DBO4 BCOM_BITERR: Shifted bits detected
X Communication with base board — shifted bits detected
XCOM_NOTREADY: Communication with safety partner MC not ready /

2304 0x0900 operational
Communication with safety partner microcontroller not ready / operational
XCOM_BUSY: Communication with safety partner is busy

2305 0x0901 e . .

Communication with safety partner microcontroller overloaded
XCOM_NONEWDATA:

2306  0x0902 - ) . .
Communication with safety partner microcontroller — no new data received
XCOM_CRCERR: Communication with safety partner detected a CRC error

2307 0x0903 N ) .

Communication with safety partner microcontroller — checksum error detected

2336  0x0920 3S RTS background communication to safety partner MC not read operational
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_ Hex Explanation
2337 0x0921 3S RTS background communication to safety partner is busy
3S RTS background communication has not yet received new data from safety
2338 0x0922
partner MC
2339 0x0923 3S RTS background communication to safety partner detected a CRC error
BGCOM_QUEUEERR: 3S RTS background c ication t
2340 0x0924 _Q grou ommunication to safety partner
detected a queue error
2352  0x0930 3S RTS VM communication to safety partner MC not read operational
2353 0x0931 3S RTS VM communication to safety partner is busy
2354  0x0932 3S RTS VM communication has not received new data from safety partner MC
2355 0x0933 3S RTS VM communication to safety partner detected a CRC error
2560 0Ox0A00 I2C_TIMEOUT: 12C communication timeout detected
2561 0Ox0A01 I2C_BUSY: 12C bus is busy
2976 OxOBAO FSoE Master finished initialization
2977 Ox0BA1l FSoE Master is shutting down
3329 0x0DO1 MC1_ID_INVALID: Identification of MC 1 failed
3330 0x0D02 MC2_ID_INVALID: Identification of MC 2 failed
3331 0x0DO03 MC3_ID_INVALID: Identification of MC 3 failed
3841 OxOFO01 FLASH_TIMEOUT: FLASH operation timeout
FLASH_LOCKED: FLASH operation failed because "LOCK" bit could not be
3842  0Ox0F02
reset
FLASH_BUSY: FLASH operation busy,
3851 OxOFOB . .
sequence error in flash programming
FLASH_ERROR: FLASH operation error,
3854 OxOFOE

programming of the flash memory failed

7.3.6. MC 1: Error line 2008

Name Err.line

Index 2008n

Object Code VARIABLE
No. of Elements 0

Data Type UNSIGNED16
Access Read

PDO Mapping No
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7.3.7. MC 1: Error module 2009n

Name Error module
Index 2009n
Object Code VARIABLE
No. of Elements 0

Data Type UNSIGNEDS
Access Read

PDO Mapping No

The table below explains the entries in object 2009 "error code".

OBJ UNKNOWN_ID

0x00 Error from module: unknown
4 0x04 OBJ_PRGCONTROLTASK_ID
X Error from module: CProgramControlTask.cpp
OBJ_SAFETYHAL_ID
8 0x08 - P
Error from module: CSafetyHal.cpp
12 0x0C OBJ_MAINTASK_ID
X Error from module: CMainTask.cpp
16  0x10 OBJ_PRGCONTRLTASK_ID
X Error from module: CProgramControlTask.cpp
20  Oxld OBJ_SYNCSAFETYPARTNER_ID
X Error from module: CSyncSafetyPartner.cpp
24 Ox18 OBJ_XCOM_ID
X Error from module: CXcom.cpp
28 OXIC OBJ_BBCOM_ID
X Error from module: CBBCom.cpp
29 OxID OBJ_VMCOM_ID
X Error from module: CVMCom module
30 OxIE OBJ_BGCOM_ID
X Error from module: CBGCom module
52  Ox34 OBJ_HELPER_ID
X Error from module: CHelper.cpp
OBJ_SYNCLINE_ID
56 0x38 - —
Error from module: CSyncSafetyPartner.cpp - sync()
OBJ_TESTHANDLER_ID
58 0x40 - -

Error from module: CTestHandler.cpp
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_ Hex Explanation
72 0xa8 OBJ_DIAGNOSTIC_ID
X Error from module: CDiagnostic.cpp
74 0550 OBJ_FSOEMASTER_ID
% Error from module: CHAL_FSoEMaster_Template.cpp
88  0x58 OBJ_INTHANDLER_ID
% Error from module: InterruptHandler.cpp
102 OxCO OBJ_SPI_ID
x Error from module: CSpi.cpp
103 OxCl OBJ_TIMER_ID
X Error from module: CTimer.cpp
104 OxC2 OBJ_BACKUPSRAM_ID
X Error from module: CBackupSRam.cpp
105 OxC3 OBJ_PWR_ID
X Error from module: CPwr.cpp
106 OxCa OBJ_RCC_ID
X Error from module: CRcc.cpp
107 OxC5 OBJ_GPIO_ID
X Error from module: CGpio.cpp
108 OXC6 OBJ_DMASTREAM_ID
x Error from module: CDmaStream.cpp
199  OxC7 OBJ_ADC_ID
x Error from module: CAdc.cpp
200 OXCB OBJ_WD_ID
x Error from module: CWatchdog.cpp
201 OxCO OBJ_FLASH_ID
x Error from module: CFlash.cpp
202 OXCA OBJ_CRC_ID
x Error from module: CCrc.cpp
203 OxCB OBJ_I2C_ID
x Error from module: Cl2c.cpp
OBJ_APPIF_ID
208 0xDO - -

Error from module: CECatApplinterface.cpp

7.3.8. MC 1: Error class 200An

Name Err.class
Index 200An
Object Code VARIABLE
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No. of Elements

Data Type UNSIGNEDS8
Access Read
PDO Mapping No

The table below explains the meaning of the entries in object 200An "Error Class".

_ Explanation

No Error

1 Serious error or synchronisation error

Internal communication error

2 L
Internal communication error
3 1/0O Error
1/0O Error
4 Error in Test Handler

Error in the Test Handler

7.3.9. MC 1: System Uptime [s] 200Ch

Name System uptime [s]
Index 200Chn

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED32
Access Read

PDO Mapping No

Units S

Default Value No default Value

7.3.10.Read / write world time [s] (LOG Time) 200Dn

Name Read / write world time [s] (GMT, UTC)
Index 200Dn
Object Code VARIABLE

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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No. of Elements 0

Data Type UNSIGNED32
Access Read / Write
PDO Mapping No

Units S

Default Value No default Value
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7.3.11.MC 3: 3,3 V Supply Voltage [mV] 2013n

Name MC 3: 3,3 V Supply Voltage [mV]
Index 2013n

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED32

Access Read

PDO Mapping No

Units mV

Default Value No default Value

73.12. Temperature warning 2016n

Name Temperature warning

Index 2016n

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNEDS8

Access Read

PDO Mapping No

Value 0°C —55°C = 0; <0°C oder >55°C = 1
Default Value No default Value

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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7.3.13.MC 1: LZS component ID 2017n

Name MC 1: LZS componentld
Index 2017n

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED32

Access Read

PDO Mapping No

Default Value No default Value

73.14. MC 1: LZS file ID 2018n

Name MC 1: LZS fileld
Index 2018n

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED32
Access Read

PDO Mapping No

Default Value No default Value

7.3.15.MC 1: LZS line 2019h

Name MC 1: LZS line
Index 2019

Object Code VARIABLE
No. of Elements 0

Data Type UNSIGNED32
Access Read

PDO Mapping No

Default Value No default Value
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7.3.16.MC 1: Read number of CORA test cycles 201An

Name MC 1: Read number of CORA test cycles
Index 201An

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED32

Access Read

PDO Mapping No

Default Value

No default Value

7.3.17.MC 1: Read number of file system test cycles 201Bn

Name MC 1: Read number of file system test cycles
Index 201Bn

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED32

Access Read

PDO Mapping No

Default Value

No default Value

7.3.18.MC 1: Read number of IAR test cycles 201Chn

Name MC 1: Read number of IAR test cycles
Index 201Cn

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED32

Access Read

PDO Mapping No

Default Value No default Value
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7.3.19.SW Build No 210An

Name SW Build No
Index 210An

Object Code VARIABLE

No. of Elements 0

Data type UNSIGNED16
Access Read

PDO Mapping No

Default Value No default Value

7.3.20.Read MC 3 error 2210n

Name Read MC 3 error
Index 2210n

Object Code RECORD

No. of Elements 3

Name Number of entries
Subindex 00n

Data type UNSIGNEDS
Access Read only

PDO Mapping No

Default Value 3

Name MC 3: Error number
Subindex 0ln

Data type UNSIGNED16
Access Read only

PDO Mapping No
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Name MC 3: Error line
Subindex 02n

Data type UNSIGNED16
Access Read only

PDO Mapping No

Name MC 3: Error module
Subindex 03n

Data type UNSIGNEDS
Access Read only

PDO Mapping No

7.3.21.Read MC 1 runtimes 2220n

Name RunTime MC 1
Index 2220n

Object Code RECORD

No. of Elements 6

Name Number of entries
Subindex 00n

Data type UNSIGNEDS
Access Read only

PDO Mapping No

Default Value 6

204909000_Safety-PLC-Modul_Handbuch_EN_1-40.docx
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Name Runtime main loop [ps]
(Designation in the XML file: Act RT)

Subindex 01ln

Data type UNSIGNED16
Access Read only
PDO Mapping No

Name Maximum of main loop runtime [us]
(Designation in the XML file: Max RT)

Subindex 02n

Data type UNSIGNED16
Access Read only
PDO Mapping No

Name Application cycle time (Par. from PS) [us]
(Designation in the XML file: App Cycle)

Subindex 03n

Data type UNSIGNED16
Access Read only
PDO Mapping No

Name Application runtime [us]
(Designation in the XML file: App RT)

Subindex 04n

Data type UNSIGNED16
Access Read only
PDO Mapping No
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Name Application CORA time [us]
(Designation in the XML file: CORA RT)

Subindex 05n

Data type UNSIGNED16
Access Read only
PDO Mapping No

Name Reserved [us]
Subindex 06n

Data type UNSIGNED16
Access Read only
PDO Mapping No

7.3.22.MC 3 main loop cycle time and max cycle time 2221

Name MC 3 main loop cycle time and max cycle time [us]
(Designation in the XML file: RunTime MC3)

Index 2221n

Object Code RECORD

No. of Elements 2

Name Number of entries
Subindex 00n

Data type UNSIGNEDS8
Access Read only

PDO Mapping No

Default Value 2
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Name Runtime main loop [us]
(Designation in the XML file: Act RT)

Subindex 01ln

Data type UNSIGNED16

Access Read only

PDO Mapping No

Name Maximum of main loop runtime [us]

(Designation in the XML file: Max RT)

Subindex 02n

Data type UNSIGNED16
Access Read only
PDO Mapping No

7.3.23.Free disk space / app size information 2230n

Name Free disk space / app size information
(Designation in the XML file: Free Disk Space)

Index 2230n
Object Code RECORD
No. of Elements 4

Name Number of entries
Subindex 00n

Data type UNSIGNEDS8
Access Read only

PDO Mapping No

Default Value 4
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Name Actual local free disk space [Byte]
(Designation in the XML file: Local)

Subindex 01n

Data type UNSIGNED16
Access Read only
PDO Mapping No

Name Actual global free disk space [Byte]
(Designation in the XML file: Global)

Subindex 02n

Data type UNSIGNED16

Access Read only

PDO Mapping No

Name Actual application code size [Byte]

(Designation in the XML file: App Code)

Subindex 03n

Data type UNSIGNED16
Access Read only
PDO Mapping No

Name Actual application data size [Byte]
(Designation in the XML file: App Data)

Subindex 04n

Data type UNSIGNED16
Access Read only
PDO Mapping No
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7.3.24.ST CPU Chip Id MC 1 (96 bit serial number) 5001n

Value

Name ST CPU Chip Id MC 1 (96 bit serial number)
(Designation in the XML file: Id MC1)

Index 5001n

Object Code RECORD

No. of Elements 4

Value

Name Number of entries
Subindex 00n

Data type UNSIGNEDS8
Access Read only

PDO Mapping No

Value

Name MC 1 id received: 1 - OK, O - failed
(Designation in the XML file: Id rx from MC1)
Subindex 01n
Data type UNSIGNED16
Access Read only
PDO Mapping No
Name Id bits 0...31
(Designation in the XML file: Bits 0-31)
Subindex 02n
Data type UNSIGNED16
Access Read only
PDO Mapping No
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Name Id bits 32...63
(Designation in the XML file: Bits 32-63)

Subindex 03n
Data type UNSIGNED16
Access Read only
PDO Mapping No
Name Id bits 64...95
(Designation in the XML file: Bits 64-95)
Subindex 04n
Data type UNSIGNED16
Access Read only
PDO Mapping No

7.3.25.ST CPU Chip Id MC 3 (96 bit serial number) 5003

Name ST CPU Chip Id MC 3 (96 bit serial number)
(Designation in the XML file: Id MC3)

Index 5003n

Object Code RECORD

No. of Elements 4

Name Number of entries
Subindex 00n

Data type UNSIGNEDS8
Access Read only

PDO Mapping No

Default Value 4
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Value

Name Identification state: 1 - OK, 0 - failed
(Designation in the XML file: 1d valid)

Subindex 01ln

Data type UNSIGNED16

Access Read only

PDO Mapping No

Name Id bits 0...31

Subindex 02n

Data type UNSIGNED16

Access Read only

PDO Mapping No

Name Id bits 32...63

Subindex 03n

Data type UNSIGNED16

Access Read only

PDO Mapping No

Name Id bits 64...95

Subindex 04n

Data type UNSIGNED16

Access Read only

PDO Mapping No
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7.4. Objects - For Internal Use Only

The objects listed below are not intended for use by the end user. Some of them are used for
configuration purposes.

Meaning/Designation

0x10F1h Error Settings

0x1C00h Sync Manager Type

0x1C32h SM Output Parameter

0x1C33h SM Input Parameter

0x2000h Ref Voltage for uC1

0x2002h Supply 5 Voltage for pC1
0x2003h Supply 3.3 Voltage for uC1
0x200Bh Number of CORA Test Cycles for uC1
0x2020h MaxAsicDataUnequalCounter
0x2212h Post Result Flag

0x2220h MC1 Main Loop Cycle Time
0x5001h Id MC1

0x5003h Id MC3

Ox5E5En Generation of the ‘Device stamp’
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7.5. Standards Complied With

7.5.1. Product Standard Applied

-  EMC Directive 2014/30/EU
>  EN61131-2:2007
Programmable logic controllers — Part 2: Equipment requirements and tests

7.5.2. Safety Standards and Directives

> IEC 61508:2010 Parts 1-7
Functional safety of electrical/electronic/programmable electronic safety-related systems
>  ENISO 13849-1:2015
Safety of machinery — Safety-related parts of control systems Part 1: General principles
for design
>  EN62061:2005 + AC:2010 + A1:2013 + A2:2015
Safety of machinery - Functional safety of electrical, electronic and programmable electronic
safety-related control systems
>  EN 60204-1:2006 + A1:2009 + AC:2010 (excerpts)
Safety of machinery — Safety-related parts of control systems -Part 1: General principles
for design

7.5.3. EMC Standards

EMC Immunity from interference

-  Generic standard DIN EN 61000-6-2:2005
Electromagnetic compatibility (EMC) — Part 6-2: Generic standards - Immunity for industrial
environments

- Product standard DIN EN 61131-2:2007
Programmable logic controllers — Part 2: Equipment requirements and tests

Enhanced interference immunity levels of safety-related applications
>  DINEN 61131-6:2012
Programmable logic controllers — Part 6: Functional Safety

EMC Emission of interference

->  Generic standard EN 61000-6-4:2007 + A1:2011
Electromagnetic compatibility (EMC) — Part 6-4: Generic standards — Emission standard
for industrial environments

> Product standard EN 61131-2:2007
Programmabile logic controllers — Part 2: Equipment requirements and tests
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7.6. Regulations and Declarations

7.6.1. Declaration ofConformity

ZERTIFIKAT / CERTIFICATE

EU-Konformitatserklarung

nach MRL 2006/42/EG Anhang Il 1.A

Hiermit erklaren wir in alleiniger Verantwortung, dass die nachstehend bezeichneten Gerate in ihrer Konzeption und Bauart sowie
in der von uns in Verkehr gebrachten Ausfihrung den aufgefuhrten Richtlinien und Normen entsprechen. Bei einer mit uns nicht
abgestimmten Anderung der Gerate verliert diese Erklarung ihre Gultigkeit. Wird das Produkt in eine Maschine eingebaut oder mit
anderen Maschinen zu einer Maschine zusammengebaut, so ist vor der Inbetriebnahme zu prifen, ob die Maschine, in die dieses
Produkt eingebaut werden soll, den Bestimmungen der Richtlinien entspricht

We hereby declare, that the following described modules in their conception, construction and form are in compliance with the
listed directives and standards. In case of any alteration of the modules, not certified by us, this declaration becomes invalid. If the
device is mounted in a machine or assembled with other parts to constitute a machine it is necessary to test that the machine itself
conforms with the requirements of the named directives

Hersteller / manufacturer Berghof Automation GmbH
Harretstrasse 1
D-72800 Eningen

Produktbezeichnung / E-I/O Safety PLC Produktnummer / 204909000
product name product number
Es wird die Ubereinsti g mit folgenden EU-Richtlinien und Normen erklért:

The requirements of the following EU directives and standards are met
Angewandte Richtlinien / applied directives

2006 /42/EG Maschinenrichtlinie entsprechend EG Baumusterbescheinigung (01/205/5601.00/17)
2014/30/EU Elektromagnetische Vertraglichkeit/ EMV/Electromagnetic compatibility EMC
2011/65/EU Beschrankung der Verwendung bestimmter gefahrlicher Stoffe in Elektro- und

Elektronikgeraten (RoHS-2)/ Restriction of the use of certain hazardous substances in
electrical and electronic equipment (RoHS-2)

har isierte / applied harmonized standards

A "
g

EN 61131-2:2007 (Auszugsweise), EN ISO 13849-1:2015, EN 62061:2005 + AC:2010 + A1:2013 + A2:2015, EN 50581:2012
Angewandte Normen / applied standards
EN 61131-6:2013, IEC 61508:2010 Teile 1-7

Bevollmichtigter fir die Berghof Automation GmbH

Z llung der technisch A. Rabold

Unterlagen (bezgl. MRL) / Harretstrasse 1

person authorized to compile the D-72800 Eningen

technical file

Benannte Stelle (bezgl. MRL) / TOV Rheinland Industrie Service GmbH
notified bodies Alboinstr. 56, 12103 Berlin / Germany

NB-Nr.: 0035 z 7 o) = B

E(F - AL e )
16.06.2017 @’l\?« ger — i.V. Dr. Arno Rabold

Beré‘/chsleilm Projektleiter
Datum /Date Business Unit Manager Project Manager

BERGHOF

Berghof Automation GmbH | Harretstrasse 1| 72800 Eningen | www.berghof com
21-0099-88-10-07-032 | 204909000_Konformitatserklarung docx

The original EC Declaration of Conformity and the associated documentation can be made available to
the competent authorities. Please contact the Project Management, as necessary.
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7.6.2. TUV Certificate

d ¥ademarks. Usisasion and spplcasion requires prier approvl

2
M
g
3
=

@ TOV. TUE

EA4

12

101222 12

EC Type-Examination Certificate

Reg.-Nr./No.: 01/205/5601.00/17

Prifgegenstand E-I/O Safety PLC, Safety Contraller fir E- Zertifikats- Berghof Automation GmbH
Product tested /O System Uber FSoE inhaber Harretstr. 1
E-1/O Safety PLC, Safety Contraller for E- Certificate 72800 Eningen
/O System via FSoE holder Gemany
Typbezeichnung 204909000
Type designation
Prifgrundlagen EN ISO 13849-12015 EN 61131-2:2007
Codes and standards |IEC 62061:2015 + AC:2015 EN 60204-1:2006 + A1:2009 + AC:2010 (in
|IEC 61508 Parts 1-7:2010 extracts)

IEC 61326-3-1:2008 + AC:2008

BestimmungsgemaBe Die sichere spei erfiillt die gen der Priifgr
Verwendung (Kat 4/PLenach EN ISO 13849-1, SIL CL 3 nach IEC 62061 / IEC 61508) und kann in
1 ded bis zu diesen Sicherheitsleveln eingesetzt werden.

The safety logic lies with the requi of the relevant

standards (Cat. 4/ PL e acc. to EN ISO 13848-1, SIL CL 3 acc. to IEC 62061 / IEC 61508)
and can be used in applications up to these safety levels.

Besondere Bedingungen Die Hnwecsa in der zugehorigen i und Betri i sowie des
Specific requirements Si sind zu
The i ions of the iated ion, O ing and Safety Manual shall be
considered.
Es wird bestatigt, dass der Prif; mit den A nach Anhang | der Richtlinie 2006/42/EG Uber Maschinen
Obereinstimmt.
It is confirmed, that the product tested ies with the i for hines defined in Annex | of the EC Directive
2006/42/EC.

Gitig bis / Valid until 2022-07-04

Der Ausstellung dieses Zertifikates liegt eine Prifung zugrunde, deren Ergebnisse im Bericht Nr. 968/FSP 1413.00/17
vom 04.07.2017 dokumentiert sind.

Dieses Zertifikat ist nur giiltig fir Erzeugnisse, die mit dem Pi "', o] 1d bereinsti Es wird ungiiltig bei
jeglicher Anderung der Prifgrundlagen fir den angegebenen Verwend weck.

The issue of this certificate is based upon an examination, whose results are documented in

Report No. 968/FSP 1413.00/17 dated 2017-07-04.
This certificate is valid only for products which are
the codes and standards forming the basis of teft

27

l—wtm‘&(e p\roduct lested It becomes invalid at any change of

E:

Berlin, 2017-07-04

Notified Body for Machinery, NB 0035 Dipl.-Ing. Eberhard Frejno

www.fs-products.com

www.tuv.com é é TUVRheinIand@

Precisely Right.
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8. Customer Service /| Addresses

Repair work on the Safety PLC Module is not permitted. In the event of a defect, return the module
to Berghof Automation GmbH Customer Service.

8.1. Customer Service

Berghof Automation GmbH
Harretstr. 1

72800 Eningen

Germany

T +49.7121.894-0

F +49.7121.894-100

E-mail: controls@berghof.com
www.berghof.com
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